COMMUNICATING EDUCATION CONCEPTS
THROUGH MULTIMEDIA

by

Rhonda Elliott and Faith Ann Newman
Supervisor: Prof. Jane M. Fritz
TR94-084 April 1994

CS4997 Senior Honours Thesis

Faculty of Computer Science
University of New Brunswick
P.O. Box 4400
Fredericton, N.B.
Canada E3B 5A3

Phone: (506) 453-4566
Fax: (506) 453-3566
Communicating Education Concepts
Through Multimedia

by:
Rhonda Elliott 206066
Faith Ann Newman 205455

Prof. J. Fritz

due 15 April 1994

CS4997 Thesis
## Table of Contents

Abstract .................................................................................................................. 1

1.0 Multimedia in Education .................................................................................. 2  
   1.1 Multimedia Computer Assisted Learning ................................................... 2  
   1.2 Models of Computer Assisted Learning .................................................... 2  
   1.3 Benefits of Computers in Education: Individualization and Interaction ...... 3  

2.0 Reasons for Eliminating Classroom Educational Packages ............................. 5  
   2.1 Signs of Poor Software Design ................................................................. 6  

3.0 Mediums Used in Multimedia Applications .................................................. 8  
   3.1 Text .......................................................................................................... 8  
   3.1.1 Timing .................................................................................................. 8  
   3.1.2 Special Effects for Displaying Text ....................................................... 9  
   3.1.3 Browsing - Links .................................................................................. 9  
   3.2 Sound ...................................................................................................... 10  
   3.2.1 Multimedia Station Environment - Factor when Using Sound .............. 11  
   3.3 Graphics .................................................................................................. 11  
   3.4 Video ...................................................................................................... 12  
   3.5 Disadvantages of Special Effects .............................................................. 12  

4.0 Suggestions for Screen Design ....................................................................... 14  

5.0 Designing the Multimedia Application ......................................................... 15  

6.0 Development of a Multimedia Application .................................................. 18  
   6.1 Page Creation ............................................................................................ 18  
   6.2 Recording a Sound File ............................................................................. 19  
   6.3 Object Creation ......................................................................................... 20  
   6.4 Reusability of Objects and Scripts ........................................................... 21  
   6.5 Animation of Science Experiments .......................................................... 22  
   6.6 Scanning ................................................................................................... 24  

7.0 Factors Preventing the Optimal Use of Multimedia in Education ............... 27  

8.0 Disadvantages of Multimedia in the Classroom ......................................... 28  

9.0 Conclusion .................................................................................................... 29  

Appendices: ....................................................................................................... 31  
   Appendix A: Sample Scripts ......................................................................... 32  
   Appendix B: Diagram of Three Computer Assisted Learning Environments ... 35  
   Appendix C: Science Quest Screens .............................................................. 37  

Bibliography ....................................................................................................... 49  

Summary Sheet of Time ....................................................................................... 51
Abstract

There have been many studies documenting the pros and cons of computers, in particular multimedia machines, in the classroom. By combining text, graphics, sound and video, applications have the potential to convey certain concepts in a more understandable manner than text in a book. Multimedia applications also have the additional capability of being interactive, which can further enhance the learning process.

In the course of researching the topic of multimedia in education, one area in particular was focused on. The authors chose to design an educational application called Science Quest for junior high science students. The purpose of this application is to convey information about the properties of light, in particular, the concepts of refraction, reflection and color. Development of such a system involves the use of multimedia equipment such as CD-ROM drives, microphones, scanners, video devices, and authoring systems such as ToolBook.

The availability of so many methods of presenting information can be quite overwhelming. It is important that careful consideration be given to how the mediums of text, graphics, and sound will be used. The outcome should be applications that do not reward error, promote interactivity with the user, do not insult the user, do not rely heavily on text, do not make use of graphics unless they add to the educational value of the program, contain significant content, and are free from error.

One of the key factors necessary when designing a multimedia application is imagination. It is important to be able to visualize what objects should be used to convey a concept, and how these objects should interact. The latter is especially important in an object-oriented environment. The possible use of animation is another reason that imagination is an essential tool of the developer. Animation can play a very important role in conveying science concepts by simulating an experiment. Through the use of animated graphics, the visual explanation can eliminate detailed background information in many instances.

There are some disadvantages to using multimedia in the classroom. Some of the major drawbacks include the cost of multimedia equipment (depending on the number of stations necessary), the lack of well-designed applications relating to the school curriculum, and the lack of training for teachers in effectively integrating computers into the classroom. With time, as more emphasis is placed on the design of applications for use in education, it is hoped that these things that are preventing the use of this powerful tool in the classroom will be overcome.
1.0 Multimedia in Education

The use of computers in education has been growing rapidly in recent years. This may be in part due to the decreasing cost of computers and related equipment, and also due to the increasing functionality of educational software. The interest shown by politicians in this area has also helped make people take notice of the computer industry, and the powerful effect it could have on the job market, if people are trained. Their willingness to spend money in this area to train people has increased the amount of research and work done with multimedia in education.

Multimedia can be used to educate outside the school system as well. Training packages and tutorials can be designed for adults in the workforce. This could enable employees to be trained in their own place of employment, eliminating travel costs. They can also complete the courses at their own pace, and when it is convenient for them. (Of course, it also means they can procrastinate taking the course, and may go either too slowly or quickly for the course to be beneficial.) Multimedia has an important role in many facets of education, however, this report will focus on the use of multimedia in a classroom setting, for students at the junior high level (grades seven through nine). In particular, this report will look at the use of multimedia in science.

1.1 Multimedia Computer Assisted Learning

The student's interaction is usually in terms of the devices connected to the computer. The student may use the mouse, keyboard, lightpen, probe, or a variety of other devices to interact with the computer. It is Barker’s opinion that most teacher’s agree that when transferring knowledge, a method using a single medium is not as effective as one using a variety of mediums [Barker, p136]. For example, as previously mentioned, some information is easily conveyed using text while other information is better conveyed through the use of graphics.

1.2 Models of Computer Assisted Learning

There are three different environments or models used in multi-media computer assisted learning (CAL). The first type to be discussed is informative CAL. It presents information to the students; this may be in a research type atmosphere, or to help them make a decision. The second approach is called exploratory CAL, and involves providing the student with a computer and a set of tools with which to
explore. The third approach is called instructional CAL, where the computer is used to deliver material that has been prepared, planned and tested. The last approach is the most sophisticated, and usually the most difficult to implement. A diagram illustrating the models can be found in Appendix B.

Barker's requirement for an application to be considered instructional CAL, includes the ability of the application to adapt to the student's pre-knowledge and their preferred method of learning. The program should attempt to assess the skills the student has learned in the course of using the application. Finally, the application should be "generative", it should be capable of producing methods of instruction and material that was not previously programmed.

The project undertaken for CS 4997 is a combination of informative and exploratory CAL. Science Quest was developed to supply information on light to science students. In this way it can be viewed as a reference. It is also exploratory, in that they are given the tools to help carry out experiments on screen, and thus can explore alternatives. With more time than a four month term allows, the application would likely be given an even further exploratory basis, with the addition of probes such as the light probe (used to sensor the brightness of light).

A multimedia environment requires the student to interact with a number of devices. The computer plays a central integrating role for all of these devices. The student will likely require instruction in the use of some of the devices, such as the CD-ROM, mouse and computer in general, depending on their background. The computer will be responsible for monitoring the student's progress, suggesting possible tasks for the student to complete, and controlling the media during the session (such as video, or CD-ROM).

1.3 Benefits of Computers in Education: Individualization and Interaction

There are many powerful ways to use a computer in education. One reason is due to the individual attention the computer can give the student. A computer can tirelessly repeat the same statement many times, and even in different ways, as opposed to a teacher who may not have time to continually go over a point for one student when the other twenty-nine students already understand the concept.

The computer has the ability to be interactive, it should therefore not be just a visual tool for the student, but something they can participate in. Without occasional interaction, the student may not give their full attention to the application. Computer applications also have the ability to be designed to focus
on the individual. If a student has a particular problem with a certain area, the correctly chosen application should concentrate on this area. This is of course in the ideal environment, in which appropriately designed programs are available to support all topics taught by the teacher. (This environment will not exist in the immediate future, and would be especially difficult to maintain with the continually changing curriculums.)
2.0 Reasons for Eliminating Classroom Educational Packages

When designing software to be used in the classroom, there are certain things to keep in mind, so the final product will be usable and promote learning. The following are some points noted on a checklist for eliminating poor educational software, found in "Multi-media Computer Assisted Learning" by Philip Barker [Barker, p150]:

= The computer should not make an audible response when a student makes an error. The entire classroom should not know when an error has been made, this could have the tendency to make students apprehensive about using the software, and cause them to spend their time worrying about mistakes, rather than learning the material.

= The software should not be designed in such a way that it awards error. It should not be fun to make a mistake. Some software packages have more colorful illustrations when the student makes a mistake, than when they answer a question correctly.

= The user should be able to control the sound. Depending on the location of the computer, it may be disruptive to other students if there are a lot of uncontrolled sound effects.

= The application should of course be free of technical problems and errors of any kind. The software and devices should be tested exhaustively. In many environments, the teachers supervising the students may not be highly computer literate, and therefore are unable to respond to even the most trivial errors.

= The student should be able to control the advancement of the screen. They should be able to learn at their own pace.

= There should be adequate instructions for the student to follow while interacting with the product.

= There should not be any insults, sarcasm or derogatory remarks to belittle the student. For example, when the student incorrectly answers a question, "Wrong Stupid!" should definitely not be flashed on the screen.

= There should be adequate documentation of the software and the required products.
Any multimedia learning environment should be designed so that the learning processes can be controlled by the student. The student’s participation should be promoted, and the environment should be motivating.

The effective use of multimedia is in part due to its use of several mediums to convey information. Text is good for communicating some ideas, while other concepts are better illustrated with the use of graphics. Sound can further enhance certain images and make learning a more rewarding and interesting experience. Some applications make use of video, probes (such as light and temperature probes), and a variety of other devices that may be connected to the computer. In some cases, workbooks are a valuable tool to be used in conjunction with the computer equipment. While we recognize the important role that workbooks can play in student’s learning, due to time constraints, the focus of this report and project is on the development of the multimedia application.

Another aspect of properly designed multimedia software is its ability to monitor student’s progress. In a classroom setting, this will be supplemented by the teacher’s evaluation of the student as well. It is not suggested that multimedia replace traditional teaching methods, rather it should be used to complement the teacher’s lessons. Effective use of multimedia applications in the classroom should help students who are having difficulty mastering certain concepts, since teachers do not always have time to give individual help.

### 2.1 Signs of Poor Software Design

When administrators are evaluating software there are certain features that they should be looking for, and these points should of course be considered by the application designer. As mentioned, applications should make effective use of interactive capabilities. The use of weak forms of interaction such as multiple choice, or true and false should be avoided. Presentations that depend heavily on text are also not advisable for use in a classroom setting. Screens should not be treated just like a book, since the possibilities provided by a computer allow the screens to be used in a much more effective and powerful manner.

Although screens should not depend heavily on text, they should also not depend heavily on pictures that do not offer any value. Graphics selected for a particular screen should provide some educational value. If the application is designed as a game, it should not be “just a game”, it should teach
something. Another feature of programs to be avoided is the use of long instructions for the user to remember; these may be difficult for the teachers to follow, let alone the students.

An additional strike against an application is its dependency on additional hard copies of text. The learning unit should be self-contained, although hard copy documentation should be available as a reference.

Evaluators also look at the size of the application. Small amounts of material that lack context are a sign of a poorly developed application. The material should be able to hold the student's attention (which is a complicated task in itself).
3.0 MediaUsed in Multimedia Applications

There are many different ways that multimedia communicates information. The most common are through text, graphics, sound and video. To effectively use these mediums of communication, there are many things to be considered. When so many options are available, it is easy to overload a simple application with too many special effects. The principle that is supposed to be conveyed can either be lost in the presentation, or it can be enhanced. It is up to the application designer to ensure text, graphics and sound work together. The application developed as the basis for this report, was treated as a learning experience for the developers; it therefore combines many special effects and methods of presentation that may not normally be used together in an application of this size. The following sections discuss in more detail how text, sound, graphics and video may be used.

3.1 Text

3.1.1 Timing

An important aspect of displaying text on the screen is the aspect of timing. By controlling the timing of displaying text, certain points can be emphasized. The designer can also use timing to increase interactivity with the user. There are several timing factors to be considered, as discussed by Alfred Bork in "A Preliminary Taxonomy of Ways of Displaying Text on Screens" [Bork, p162]. Most systems display text on the screen as quickly as possible, at channel capacity. It may be better to control the rate at which text is displayed, so the user is not overwhelmed with a large amount of text to read at once. Users should also be able to control when things appear on the screen, since people do not read at the same pace. It is very annoying to people who read at a faster rate to have to wait for the next block of text to appear. It is equally annoying for people who read at a slower rate, and may be halfway through a section of text when it disappears from the screen. Avoiding the "now you see it, now you don't" text also makes sense if the user has to look away from the computer for a moment. When they return their attention to the screen, they may have missed crucial information that was only displayed for a short time.

When certain words require emphasis in a timed fashion, it is possible to pause before a keyword. It may also be advantageous to have timed delays between the display of text and graphics. This allows the user to shift their attention from one thing to another. The approach taken in most of the Science Quest application is to allow the user to be in control, by letting them use the mouse to signal when they are ready to move on.
It was necessary in particular to control the way graphics were displayed with the text on the screen, otherwise, the experiments could not be viewed in a logical fashion. If all the graphics were displayed at once, the interactions between two pictures would not be effectively presented. It would be similar to a comic book effect, where the reader knows that between frames movement has taken place, and they must assume what the movement was. In the Science Quest application, it was not the intention of the designers to have the user make an assumption, rather the user should learn from seeing exactly what may happen.

3.1.2 Special Effects for Displaying Text

There are methods other than timing to be considered when trying to emphasize certain points. Physical methods of emphasis could aid or distract; it is important to pay attention to their use and possible misuse. These methods include: fonts, font size, flashing or blinking, reverse video, bold, text movement, color, underlining, striking-out (putting a line through the text). It is easily possible to overuse these special effects. An example is the use of several different colors of text which may make it difficult to read. If text is displayed on the screen in the following manner for instance, it may be also be annoying, and more difficult for the reader to comprehend:

This sentence uses many different methods of emphasizing text; too many special effects tend to have a detrimental effect on the presentation.

Although the above sentence is slightly exaggerated, it does illustrate an important point. When so much is available to the designer, it is easy to get carried away. It is imperative that the designer use special care not to go to the extreme when adding these effects. These methods of text emphasis are very powerful when used in moderation.

3.1.3 Browsing - Links

When designing an application it is a nice feature to have a browsing facility. If the user wants to quickly see what is available, they can do so. In the case of an educational package being used in a classroom, it is also nice to be able to pick up where the user left off, if they do not complete something within the class time period. The science application that was developed uses a series of menus, to give the student the option of completing only a portion of the tutorial at a time.
When the user enters Science Quest, a main menu displaying all of the available topics is presented. When the student selects a topic they wish to view, they are taken to another screen with a list of subtopics. The student may either make selections of certain subtopics, or click on the right arrow to view each of the subtopics within the section. At the end of the last subtopic, the student is automatically taken to the next list of subtopics for the next main topic. Throughout the program the user can always come back to the main menu by selecting exit on any screen. From the main menu, upon confirmation that exiting is what the student wants, the student can exit the application.

The menu system is very easy to implement using ToolBook. The button object, for example, can be used with a script; upon clicking the button, the script is activated and the user is taken to another location of the application. All objects on the page may be named, including the page itself. This makes going to another page easy; even though page numbers are changing and sometimes difficult to remember, the page name will stay the same. (Most people would admit that it is easier to remember a page with a recipe for chocolate fudge is on a page called chocolate-fudge, than that it exists on page 27.) An illustration of the simplicity of linking pages in ToolBook is the following script (written in ToolBook's programming language, OpenScript) used in Science Quest to go to the main menu:

```plaintext
to handle buttonDown
  go page main-menu
end
```

### 3.2 Sound

Multimedia presentations give the designer many alternatives over simply displaying text. There is also the aspect of sound, graphic and video components that may be added. The addition of sound, in particular voices, is a major benefit in educational software for the junior high school student. When teaching science it is important that the student pay attention to details. When reading information themselves, the student may "skim" the material. It may be the case that they are not proficient readers or lack comprehension skills. The concept of the sentence could be lost in the syllables of the words. Giving the student the option of listening to someone else read the information may help them grasp the concept that is being illustrated faster than reading the material on their own. It can even help students improve their reading skills, by giving them the opportunity to read along with someone else. They should, of course, be given the option of going over the material quietly on their own, unless headsets are available, since, depending on the classroom situation, the noise may disrupt other students.
In addition to voices, the use of sound may be used to enhance a presentation in other ways. The use of beeping, or other sound effects, can be used when the user makes an error, or to get the user's attention. As in the case of emphasizing text, sound effects can be used to the extreme, and can become annoying very fast. In Science Quest sound was used minimally for special effects, but more extensively for its vocal capabilities.

3.2.1 Multimedia Station Environment - Factor when Using Sound

The environment in which the computer is placed in a school can have an impact on its effectiveness. Students may feel freer to explore and take advantage of the sound capabilities in a computer lab than they would in a classroom. Students working at a computer in a classroom may also feel self-conscious about making mistakes when they are the only person at the computer, as opposed to a group of students working on several computers in a lab. Of course there are also advantages to having a computer in the classroom. When time permits, it is easier to go over to another table with a computer than to change rooms. Teachers also do not have to worry about the lab already being booked. An additional benefit is to be able to let one student having trouble with a particular concept get individual attention by completing a tutorial.

3.3 Graphics

The use of graphics may help illustrate certain points more effectively than text. For instance, when trying to give someone a clear understanding of what a triangle is, it is probably more effective to show them a picture than give them a mathematical formula. Graphical images may also keep the student's interest, whereas screen after screen of text may become monotonous. An effective integration of text and graphics is important in giving the student an association that will help them remember facts.

Graphics were used extensively in the development of Science Quest to illustrate concepts related to light. With the exception of people who are color-blind, it is probably more effective to show the components of light in the form of pictures, than in textual format. There have been many studies performed to back up the idea that pictures can present information more clearly than text. While pictures can be used in a book, they are especially effective in a computer environment, where there is the added capability of animation and movement. The graphics used in developing the application have the additional ability to show animation and movement. This feature offers many advantages when trying to illustrate scientific concepts, especially those related to light such as reflection and refraction.
These advantages would presumably hold in many other areas, and are not unique to science. The use of motion makes the application "come alive", it gives power to the presentation.

3.4 Video

The current technology in multimedia allows the addition of video to an application. This can make a presentation stronger by letting the students see that the science concepts being illustrated through text and animation are actually valid in real life. In many classrooms, the tools to perform extravagant experiments are not available. It is beneficial for students to see the actual experiments performed on the screen. It is always easier to believe something to be true after seeing it. There are many times that classroom experiments performed by students are not done under ideal conditions. With a lot of noise and commotion, things can easily be done improperly or haphazardly. This can lead to the experiment not working. When experiments do not work as expected, the result can either be a learning experience, or cause the students to become disillusioned and not believe the concept to be true. A lot of the benefits gained by doing classroom experiments depend on the teacher conducting the class. In the case of adding a video experiment to an application, the student can see what should actually happen under ideal circumstances, and perhaps try the experiment on their own, comparing results.

Although the use of video can be powerful when integrated into an instructional application, there are some problems connected with the use of video. One of these problems is the amount of storage space required for the video segments, even for a short video segment. Another problem is the slow retrieval time. The appearance of the video segment is not as good as on a television. The motion may also appear "blocky" when compression techniques are used to store the video frames. This problem is being overcome as technology improves rapidly in this area.

3.5 Disadvantages of Special Effects

A drawback of using special effects such as differently formatted text styles, the use of graphics, and the use of video is the time to effectively integrate them into the application. On the other hand, it could be argued that by not spending the time to develop the application properly, the finished product will not be effective and thus time was wasted anyway.

Another drawback is the amount of space required to store video and graphics. The pictures scanned in for the Science Quest application ranged in size from half a meg to almost two megs,
depending on the picture size. (The pictures scanned in ranged in size from a standard four by six inch photograph, to an eight and a half by eleven inch page). To save on space, the files can be compressed, but they still take up a fair amount of space.

A disadvantage of using video in applications is the lack of control that the user has over the pace at which the video runs. If the use of a pause button is available, it does help overcome this issue, so the user can stop the program and think about something for a little while if needed. Another disadvantage is the difficulty of repeating a particular segment if something is missed. If the video in the application is used in a way similar to a VCR, the user can pause, rewind, and forward as necessary. It is advantageous to spend additional time to integrate the video into the application in this manner.

An argument can be made for adding special effects to an application because of the competition for student's interest. The designer of educational software is competing with video game graphics and special effects present in games such as Super Nintendo. From using such products, children are accustomed to mind-boggling effects using graphics and sound. These teen-aged users are very demanding and expect a lot from a computer system.
4.0 Suggestions for Screen Design

Alfred Bork of the University of California, at Irvine, [Bork, p147] has done extensive research in the area of computers in education. In particular he has worked with teams to produce educational applications. Bork makes a number of suggestions for developers when designing screens for educational applications. It is his opinion that a poorly structured screen will not deliver the information in as effective manner as a screen designed with the following principles in mind (these were followed when designing the science application):

= The designer should leave some blank space on the computer, since as opposed to the printed page there is no charge for space on the computer system. Any information that is not needed should be taken away, to prevent cluttering the screen. The screen should not keep every interaction, or box of text displayed for longer than is necessary.

= When designing applications for students who are weak in understanding verbal information, it is a good idea to give information in a visual manner, perhaps through graphics.

= Timing should be used to make the text more readable. Stop displaying text when there are periods or question marks. This approach is questionable, since readers digest information at different rates, so it may be annoying to fast readers with a high comprehension level not to be able to read at their own tempo. This approach was initially used in the science application, and later replaced with buttons and scripts to allow the student to proceed at their own pace.

= Short lines should be used to increase the readability. Natural phrases should be kept together on the lines, instead of separating them over several lines. Bork suggests it may be an advantage to use different text justification styles, such as right-justified text.
5.0 Designing the Multimedia Application

The following is an explanation of the design concepts that were considered in the development of the Science Quest multimedia application. The multimedia application was developed at the University of New Brunswick using a software package named ToolBook (version 1.53), by Asymetrix. This discussion could serve as a guideline for the design and development of any ToolBook application.

ToolBook is an object-oriented programming language; thus, traditional methods of designing computer applications cannot be used to develop a ToolBook application. Instead, a designer must think of the application to be designed primarily in terms of objects and the operations that may be performed on the objects. The operations that may be performed on an object are coded into a script associated with the object. For example, a designer may wish to design a button or some other object which can perform an operation, such as turning to the next screen, when the button or object is depressed using the mouse cursor. This can be accomplished by designing a script which uses features of the OpenScript language, the programming language of ToolBook, to cause a reaction to the action of depressing a button or object.

The first step taken to design the Science Quest application was to decide what information would be presented. This involved researching background information of science concepts and experiments which could be presented using a multimedia application. The topic chosen to be presented by the application was light, with emphasis on the concepts of refraction, reflection, and color. The key factor to this research was imagination; it was necessary to imagine how multimedia could be used to enhance traditional methods of communicating science concepts to junior high students. Without imagination, it would not have been possible to develop any part of the multimedia application because object-oriented design involves thinking about objects and how they interact. As science concepts were researched, it was essential to imagine how objects could be used to visually present a concept using a series of linked computer screens, called pages in ToolBook terminology. These visualizations of how the pages would appear aided in the paper-based design of the application.

The design document did not consider the low-level detail of how objects would be represented, since ToolBook is an object-oriented programming language. The design document, however, did include drawings of all of the objects to be created during the development phase. This involved considering the way in which ToolBook creates each page included in a book created using ToolBook software. Each time that an additional object or part of an object was copied or created using ToolBook software, it was placed on a new layer of the page on which it is drawn. The drawings made it possible to design the pages which would be used in the multimedia application.
Objects which appeared in the same location on multiple pages were placed on a background page. The objects placed on a background page were permanently displayed; there was no means of temporarily hiding the objects. Objects not drawn on a background page were drawn on layers of a foreground page, since every page consisted of both a foreground and a background page. Objects drawn on foreground pages could be either temporarily or permanently shown on a page. The fact that the initial design of such objects was easy to program made it possible to easily modify the initial design during the development phase, in order to improve the effectiveness of the multimedia application.

To design each page, consideration was given to all objects included on the page and how those objects interacted in order to present background information to a science concept or conduct an experiment. In all cases, it was necessary to imagine how each concept could be presented using the graphics, text, sound, and picture scanning facilities of the multimedia computer; it was necessary to consider how these audio and visual effects could be used to keep a junior high student interested in the presentation of the science concepts and experiments. With these considerations in mind, the text and graphics included in the multimedia application were designed on paper. An attempt was made to minimize the amount of background information about a science concept which was presented at one time, so as not to overwhelm a student with text displays. A major advantage of presenting the science concepts through multimedia was the ability to design an application which could use animation features to simulate a science experiment. Animation was used to present a visual explanation of science concepts; thus, detailed explanations of background information were often unnecessary.

The design of the interactive screens or pages involved designing objects which could be used in the multimedia application, and planning methods through which objects could interact with each other in order to illustrate a science concept. The design specification created was not a detailed design specification document, since it was difficult to design exactly how the objects would interact without a thorough understanding of how the ToolBook features could be used to implement the objects and their behavior. The application design, however, served as a critical basis from which objects and their behavior were defined using ToolBook features experimented with during the application development phase.

One important component incorporated into the design of the interactive screens was to design methods which encouraged interaction between the student and the multimedia application. This was accomplished by designing objects which could react to the occurrence of a particular event. For example, a water faucet incorporated into the design of an interactive screen was expected to fill an empty glass with water and stop when the glass was full. Thus, the design of the interactive screen
involved designing objects such as the water faucet and glass, and planning for the actions which could be invoked by the objects. Student participation was made possible through the design of objects which invoked a script to simulate events, such as turning on a faucet, that occurred during some stage of a science experiment.

The goal of the design phase was to design objects which could be created using ToolBook software, so that the behavior of such objects could be used to illustrate science concepts and experiments. The desired product was an application which could serve as an enhancement to traditional methods of communicating science concepts to junior high students.
6.0 Development of a Multimedia Application

The following is an explanation of ToolBook features which were considered in the development of the multimedia application. Various features which were incorporated into the multimedia application developed for this thesis are discussed, in an attempt to provide information about which features proved most useful in our attempt to develop an educational multimedia application. In cases where an effort was made to develop an experiment or background information using more than one ToolBook feature, the advantages and disadvantages of each alternative will be discussed. Our approach was to learn only the basic features prior to beginning to develop the application; additional features were comprehended and experimented with during the development phase. This proved to be an effective way to learn about ToolBook, OpenScript, DeskScan, and SoundRecorder.

6.1 Page Creation

The first step of the development phase was to translate ideas written down on paper into pages which presented a science concept or experiment. For each page, it was necessary to decide how the background page would appear. A background page was not created for each page in a book; instead, each background page was used for multiple foreground pages. Thus, careful consideration was given to the color given to a background page, and also to the objects placed on a background page since they appeared on each page associated with the background. Every page had to have a background and foreground page associated with it; thus, one useful option was to place buttons on a background page which were capable of turning forward or backward one or more pages. However, it was determined that when a page of a book was to be linked to a page not located directly before or after the starting page, it was best to place buttons used to turn pages on the foreground page. This was necessary because the script of a button on the foreground page permitted a script to be defined which could specify the name of the page to be displayed next. Thus, if the pages of a book were renumbered, the button scripts would not have to be modified. If the same button and script were defined on the background page, every page which used the background page would turn to the page explicitly specified in the script. Thus, a button on a background page was used to turn pages only when the page to be turned to was the next, previous, or the same page for all of the pages sharing the background. Alternatively, the link button (rather than user-defined scripts) could have been used to link the pages in the correct order and the problem of going to the wrong page would have been prevented since page ids never change.

ToolBook terminology for a file which stored the pages of the multimedia application was a book. Each book contained one or more pages which were linked either to pages in the same book or
pages in a different book. Pages from a different book were linked to by importing the book into the main book for the application. This was accomplished by selecting "Import" from the "File" menu under the main ToolBook menu. Once the import menu was displayed, the ToolBook option, under "Import from" was checked, and the name and directory of the imported book was selected. The facilities for importing a book into the main book for the application made it possible for developers to work on books containing separate parts of the thesis project, and then integrate the books to achieve the final product.

The order in which pages of a book were created did not matter, since each page had page properties which were used to link the pages together in a user-defined order. The page properties of an individual page were set by selecting "Page Properties" from the "Object" menu. A unique page name was specified in the page properties information for each page, since this greatly simplified efforts to specify exactly which page a button script should direct a user to. Forward, backward, and exit buttons and an associated script for each type of button were created on each page of the Science Quest application. Since Science Quest was a menu-driven system, button scripts were used to specify the unique name of a page to be turned to, and to cause the application to turn to the specified page; this eliminated the need for pages to be placed in order.

In addition to using a button to specify how to link pages, it was also possible to play a pre-recorded sound when a page was turned, simply by invoking a script to play a sound wave file having a .WAV extension. Sound wave files were created using the Sound Recorder software package under WINDOWS. Buttons were also created to provide the user with the option of invoking a sound file which would read text used to give the application user background information about a science concept or experiment. The ability to use audio effects to enhance visual displays of text is a multimedia feature which is believed to help keep students interested in the topic being presented. The ability to create buttons and other objects which were capable of combining audio and visual effects made it possible to transform pages of an application into a presentation of light concepts and experiments.

6.2 Recording a Sound File

Initially, problems were encountered while trying to record sound for the application. The sound recorder that comes with Windows version 3.1 was used to record sound. The wave files that are included as samples worked properly, however, recording sound proved to be impossible with the microphone attached to the system. When a different microphone was installed, it was an easy process. Sound could be recorded by clicking on the symbol for start, and clicking on stop at the end of the recording. The wave file could be played back in its entirety, or a portion at a time, by starting and
stopping its playback. Before the sound could be heard, the volume had to be increased by 25% a few
times (usually four to five times), under the effects pull-down menu. When the volume was increased the
line graph on the sound recorder would show movement indicating a sound pattern. When the speakers
were attached, the increase by 25% did not have to be done as many times.

6.3 Object Creation

The ToolBook documentation suggested that the application design documentation must
consider the details of how each component of all objects and text to be placed on a screen will appear.
It is our experience however, that it was not compulsory to consider the order in which every component
of an object would be drawn prior to developing the multimedia application. The order in which layers
of a page were used to represent an object, however, was important to consider during the development
phase. As each component of an object, such as a square or circle, was drawn, it was drawn on a separate
layer of a page. The order in which these layers overlaid each other was important in cases where the
developer attempted to give a realistic view of an object and its behavior in an animated process. It was
much easier to modify the order of layers used to draw an object at the time when the layers were drawn,
since ToolBook features existed to move the layer on which a component was drawn either closer to the
background or closer to the front layer.

The ability to modify the order of the layers on which components of a larger object were drawn
was useful in the animation of science experiments. In one experiment, it was necessary to illustrate how
water from a faucet was poured into a water glass. In order for the water in the glass to be seen by the
application user, it was necessary to ensure that the layer number of the water glass object was less than
the layer number of the water object. The water glass, having a lower layer number, was placed closer to
the background layer than the water; thus, the water appeared to be drawn in front of the water glass.
The layer on which any object or group is defined can be moved closer to the background by selecting
either "Send To Back" or "Send Further" from the "Object" pull-down menu. Similarly, the object can be
moved closer to the front layer of a page by selecting "Bring to Front" or "Bring Closer" from the
"Object" menu.

The appearance of an object drawn on a page was also modified using the "Transparent" and
"drawDirect" properties of an object. These features were selected from the "Draw" menu; if a check-
mark was placed beside them, they were set to TRUE. The "drawDirect" property was set to FALSE for
those objects in the application which appeared to disregard the layer order of objects drawn on a page
and always appear on top; this permitted objects to be overlaid by other objects according to their layer
order. This feature was used in animation scripts to ensure that objects would appear to move in front of other objects, rather than behind other objects. Another advantage of setting the drawDirect property to FALSE is that object motion appears smoother because the objects do not flicker. Similarly, the transparent option of an object was set to TRUE in the application to make it transparent, so that the object drawn on the layer behind the transparent object would be viewed through the transparent object. This feature proved useful for overlaying portions of a text field with a colored transparent rectangle, giving the portion of text overlaid the effect of being highlighted. This made it easy to highlight application instructions. Properties such as Transparent and drawDirect were experimented with in order to obtain the desired appearance of objects during the animation of a science experiment.

6.4 Reusability of Objects and Scripts

A powerful capability of the ToolBook software package used to develop the multimedia application was reusability of code. The development of the multimedia application involved creating or copying text fields and other objects drawn from various geometric shapes such as circles and irregular polygons. A useful feature of ToolBook was the ability to select two or more objects (by holding down the SHIFT key and selecting the objects with the mouse) and place the objects into a group, using the "Group" menu option which could be chosen from the "Object" menu. Assigning objects to a group made it easier to refer to the objects in the group, and made it possible to define a script which could be invoked when any part of the group of objects was selected using the mouse. It was also determined that it is possible to copy a group of objects to a different page in the book. If necessary, the group of objects copied to a page could be ungrouped without affecting the group created on the page from which the group was copied. However, this is a destructive process which will destroy any existing script defined for the group being ungrouped. A group of objects can be ungrouped by first selecting the group and then selecting "UnGroup" from the "Object" menu. The ability to refer to a collection of objects as a group proved useful during the process of animating a science experiment, since an animation script could refer to and act upon all objects in a group at the same time.

Another useful feature that was used to develop the multimedia application was to copy objects to another page without grouping the objects. One or more objects were copied to a new location simply by selecting the objects to be copied by holding down the SHIFT key and using the mouse to select the object(s); once the object(s) had been selected, the "Copy" option was selected from the "Edit" menu. The page to which the objects were to be copied was then retrieved, and the option to "Paste" the objects was selected from the "Edit" menu. The cut, copy, and paste features of ToolBook reduced the amount of time required to develop the science experiments about light, since it was possible to reuse both
objects and scripts on multiple pages of the multimedia application developed. This was useful, since the apparatus used to conduct an experiment was often used in several stages of a science experiment.

The ability to cut and paste scripts associated with an object also simplified the application development phase, since the behavior of similar objects could be modeled by reusing code in scripts. A script to be copied from a selected object or group of objects was accessed by selecting the "Object Properties" or "Group Properties", respectively, from the "Object" menu. By highlighting the portions of the script to be copied and then selecting "Copy" from the "Edit" menu, the script was copied to a clipboard. The script was then exited and the script window for a different object was accessed from the "Object" menu as previously described; the script was then copied from the clipboard into the script window by selecting the "Paste" option from the "Edit" menu. The ability to reuse scripts reduced the time required to develop the multimedia application, since scripts which had been previously created and tested were reused for objects exhibiting similar behavior.

6.5 Animation of Science Experiments

A challenging task in developing the multimedia application was to effectively illustrate a science experiment. The primary means of accomplishing this was done through animation. Two methods of animation were initially incorporated into the multimedia application; however, a method of drawing an object directly onto the interactive screen, referred to as "draw direct", did not prove to be a user-friendly alternative, so it was removed from the multimedia application. The script that is being referred to is that of a prism which was used to illustrate the concept of refraction. Animation was necessary to demonstrate how a beam of white light could be separated into the seven colors of light which could in turn be bent by a second prism such that the colored light waves would again combine to form a beam of white light. (These scripts are listed in Appendix A.)

The "draw direct" animation method created an animation script using ToolBook's script recorder features, "Start Recording" and "Stop Recording", which could be accessed from the "Edit" menu under the ToolBook main menu. Once the recording was started, the recorder would record into a script any actions initiated on the screen by the application developer until the recorder was stopped. For example, the recorder would record the coordinates of any object, such as a beam of light, drawn on the screen. The movement of an object could be recorded by frequently clicking on the left mouse button as the object was moved across the screen to its new location. In addition, it was also possible to modify an object by resizing it or changing its color. When the developer had completed the animation to be performed, the "Stop Recording" option was selected, and the script created was made available for use
as a script for some object defined on a page in the multimedia application. The script could be appended to, or defined as, the script for an object by selecting "Paste" from the "Edit" menu under the script window for the object or group. When ToolBook's script recorder is used to record the steps taken to draw an object on a page, the recorded script will physically draw the object on new layers of the page from which the script is invoked. Thus, action must be taken to delete the object drawn by the script; otherwise, the number of layers belonging to the page on which the object is drawn will increase indefinitely.

The main reason for removing the script created using the "draw direct" method of animation was the inability of a cleanup script, which deleted the objects drawn directly on the page, to verify that the object to be deleted actually existed. In cases where a student did not complete the refraction experiment, the application attempted to delete an object which did not exist and an error message was reported by the application. A second reason for not using the "draw direct" animation method was the fact that the objects drawn on the screen were drawn using the default colors for fill and border which were currently set in the color palette at the time when the animation process began. This made it possible for the default color settings to be erroneously modified such that the colors used to outline or fill the light beams drawn on the screen would be inaccurate. Thus, it was not useful to have an animation script draw a spectrum to illustrate the colors of light if the colors shown might possibly be inaccurate. This method of animation was a stepping stone toward the animation method which proved most useful in our efforts to develop the multimedia application.

The method of animation used to develop the multimedia application makes use of the hide and show commands of the OpenScript language. Each object to be displayed on a particular screen or page was created, or copied, to the page on which it was to be displayed during the presentation of a science concept or experiment. Each object was then given a name and the hide command was used to hide the object. A script was then created to animate the movement of any objects expected to move during the science experiment. The animated movement of objects was accomplished through a process of recording the movement of an object using the "Start Recording" and "Stop Recording" options which were selected from the "Edit" pull-down menu, as previously explained for the "draw direct" method. A script was automatically created by ToolBook which could be appended to or defined as the script for any object defined in the multimedia application. The script created was then modified to make use of the hide and show commands to hide or display, respectively, any object or group at the appropriate screen position and time during the animated science experiment. An object will be displayed at the location where it was hidden last. Upon completion of the experiment, it was necessary to move any objects moved during the animation of the science experiment back to their starting position. This method of combining animation with the hide and show commands was the most useful way of simulating science experiments about light. Once the initial problems with the animation of science experiments were
overcome, animation scripts were easily developed which could initiate the actions required to illustrate a light experiment or concept.

6.6 Scanning

It is a tremendous advantage to be able to scan in pictures and use them, rather than recreate the images yourself on screen using drawing packages. For the scanned in picture to be of good quality, attention must be paid to the settings of the scanner. Pictures and photographs for the Science Quest application were scanned in on a Hewlett Packard ScanJet IIc/ADF scanner, using the DeskScan II software (version 1.0). Publisher's PaintBrush (version 2.00) and Corel PhotoPaint (version 3.0) were then used to "touch up" the scanned in images.

For the Science Quest application, two different types of pictures were scanned in, photographs and colored pictures from books. It was determined that the best setting for scanning in the photographs was the one specifying colored photograph. The best setting for scanning in colored pictures was millions of colors. The brightness and contrast was also adjusted, and the picture rescanned several times, to obtain a better picture. Two different software applications were used to adjust the scanned in pictures. Both Corel PhotoPaint and Publisher's PaintBrush have many of the same features for adjusting pictures and produced similar results. It is a matter of personal preference in choosing one application over the other.

The pictures as scanned in were not useable. It took approximately two to three hours to get a picture ready for use. The pictures were brought in as bitmaps, into a software package for retouching. Corel PhotoPaint was found to be easier to use than Publisher's Paintbrush, since it had some additional features for touching up photographs. It was also easier to adjust the brightness and contrast with the Corel software. While in the Corel software, after retouching the picture, it was read into CorelDraw and saved as a Window's metafile. Files stored as a metafile can be brought up faster in ToolBook than a file stored as a bitmap. The other difference between metafiles and bitmaps is the size of the graphic when imported into ToolBook. Files that are stored as metafiles take up a small rectangle in the upper left corner of the screen, and need to be enlarged by pulling on one of the corners. Files that are stored as bitmaps may take up the entire screen when brought into ToolBook, and generally need to be made smaller.
When in Corel PhotoPaint, pictures can be filtered. Different things can be done to the pictures depending on the file format. The photographs were scanned in as colored photographs, and were read into Corel PhotoPaint as 256 color bitmaps. Not all of the tools and filters are available for working on 256 color files; the pictures could either be converted to 24 bit color, or worked with using the limited toolset. Since 24 bit color takes up much more space, the tool limitation was considered to be the better alternative. (It also takes a long time to convert to 24 bit color and conversion takes up a lot of memory.)

The pictures were filtered using Brightness and Contrast and Remove Spots. Other filters were tried but either made the picture blurrier, or appeared to make no difference at all. The equalize filter is used to redistribute color throughout the picture. This filter makes the darkest color black and the lightest color white. It made a lot of the photographs black since the photographs were small and had a lot of detail, thus equalize was not used in this format. It is possible that extensively changing the settings could improve the image, however a setting better than the default could not be found. The pixelate filter makes the picture block-like, and also did not improve its appearance.

One filter had a positive effect on the colored picture (from a book), and a negative effect on the photographs. The remove spots filter was used to remove small, medium and large spots from the colored picture. Its effect was significant, giving a smooth appearance, although it does take between three and five minutes to remove the spots depending on the size of the image. When the remove spots filter (any size) was applied to the photographs, the effect was certainly noticeable. However, the colors in the photograph were changed so drastically, the objects in the photo were no longer recognizable.

The main filter used in Corel PhotoPaint, for both types of scanned images, was the brightness and contrast filter. There were two different graphs displayed, one showing brightness the other contrast. By using the mouse to drag the arrows below each graph, it was very easy to look at different levels of brightness in the picture. The time to redisplay the screen after adjusting brightness and contrast depended on the size of the picture, but was not unreasonably slow. If the picture was not improved by the change, the filter could be cancelled.

Other steps aside from filtering were used in Corel PhotoPaint to improve the appearance of the image. These included zooming the image to 300% or 400%, and then using the painting tools to sharpen the image. The main tools used were the fountain pen, to color pixels individually, the paint roller, to fill a selected area, and the spray can to spray an area with dots. This is a time-consuming process, and of course the larger the image, the more time it takes.
One problem with scanning colored pictures from books involved the lines drawn around objects in the picture. There may be a medium blue triangle on a slightly darker background, with a light blue outline. There is not a distinct separation of color, and although adjusting the settings on the scanner software helped alleviate the problem slightly, it did not eliminate the problem. To the human eye the picture was very clear, but the scanner did not seem to recognize the different shadings, and the resulting image was very "cloudy". For the picture to be of high enough quality to use, a great deal of effort had to be put into improving the image.

Other sources of graphics for the Science Quest application include the clip-art libraries for both ToolBook and CorelDraw!. The images selected from ToolBook did not require extensive alterations in color, and could be adjusted in ToolBook itself. Those selected from CorelDraw! were colored in either CorelDraw! or Corel PhotoPaint, and saved as a Windows meta-file.

Even with the extensive clip-art libraries available, many desired pictures were not readily available and had to be created using the drawing tools in ToolBook. The sensitivity of the mouse made this task quite tiresome, especially when grouping several small objects together to form a larger object. When selecting objects that are close to each other, it is very easy to "unselect" items that were already selected, without realizing it.

When using imported graphics in ToolBook, the speed of drawing the page is reduced a great deal. You can wait up to 30 seconds to view a page. This is bothersome when working with that page, since every time a window is opened affecting the graphic, the picture is redrawn, leaving the user to wait. Although several pictures were scanned in, a limited number were actually used in the application due to the excessive length of time required to display a screen with a scanned in picture.
7.0 Factors Preventing the Optimal Use of Multimedia in Education

An important point made by Alfred Bork concerning the use of computers in education is related to the amount of training teachers have had in the area of using computers. Brief workshops do not always provide teachers with enough information to understand how to effectively integrate the computer into the classroom environment. Teachers may not have much general knowledge about the operation of computers. This is especially true of teachers who completed their education a number of years ago. Teachers now entering the profession will probably have on average more knowledge concerning computers than teachers who have been teaching junior high students for five or more years already.

Schools rely very heavily on the curriculum, especially now that provincial achievement exams compose a percentage of the student's final mark. It is a good idea to design computer applications that are based on the curriculum. Before designing the Science Quest module, the textbooks used for grades seven through nine Science in New Brunswick were obtained. The module was designed to supplement the textbook sections on light. It is important that computer professionals with some knowledge and training in education be assigned the task of designing and producing applications for education. Although teachers know best about what they want to teach, they can not be expected to develop their own software, although it is important to consult them to ensure the application being developed will be useful.

Developing applications for educational software requires competent developers, carefully planned material, a sound curriculum to base the application on, and funds to pay for development. As an example, the Open University in the United Kingdom spends approximately one million dollars to develop online college courses [Bork, p224]. This is probably a higher amount than necessary to produce a supplement for a junior high science course, since the college course is performed entirely on the computer.
8.0 Disadvantages of Multimedia in the Classroom

Of course there are pros and cons to everything. Some of the main disadvantages of using multimedia in the classroom include:

= The cost of multimedia equipment and software can be high, though it is now decreasing. The price of a 486SX computer with a harddrive and four meg of RAM is less than one thousand and three hundred dollars, and an additional sound card can be purchased for around one hundred and fifty dollars (price obtained from MultiTech flier). This price is reasonable for a basic multimedia system, (it is advantageous to have a CD-ROM drive as well, but development and use of a system can be accomplished without one, as the authors of this report realized). However, as good as this price may be, when schools are having trouble budgeting for textbooks and supplies, it is difficult to justify the expense of computer systems, even though benefits may be realized in the future.

= Developing applications is time-consuming, and in the past there have not been many good applications. With authoring systems such as ToolBook, it is relatively easy to learn how to develop applications, but there is more to development than knowing how to use the package. In particular the developers must have a sense of creativity and a certain artistic flair that is required to produce a package that will be pleasing to the average user.

= Device interfacing may be difficult, although the designer should be able to overcome this, with the vast amount of equipment on market. There is a multitude of multimedia devices on the market, and the developer must be well-versed in computer jargon to separate the genuine multimedia from the advertising hype.
9.0 Conclusion

Multimedia has the potential of being a very useful tool in educating students about science. There are many advantages to be obtained from a tireless, interactive application. The effective combination of several types of mediums to illustrate key concepts based on the curriculum may help get the point across to students in a more effective manner than simply reading about it in a book. It is important that a number of criteria are followed when designing an application for educational purposes. If, for example, screens rely too heavily on either text or graphics, the application will tend not to be as effective. The development of such an application takes a great amount of time, effort and consideration.

The inventability of the multimedia application developers was limited only by their imagination. The goal of the development phase was to model science experiments which could be used to enhance traditional methods of communicating science concepts about light to junior high students. The multimedia application developed was an audio and visual presentation which includes both background information and experiments about light. The application was designed to facilitate easy movement through parts of the application by permitting the ability to exit from the application at any time or skip pages of the application. An experiment can be repeated simply by returning to the menu from which the experiment was initially invoked and re-invoking the experiment; thus, students can learn at their own pace. The application permits a one-to-one relationship between the application and the student, combining color and special effects in an attempt to enhance traditional methods of communicating science concepts to junior high students.

There are some disadvantages to the use of multimedia in the classroom. The cost of the equipment can get very high depending on the number of systems required for the desired learning situation. The development of educational applications is also time-consuming, and therefore quite expensive. Even after obtaining proper equipment and software, it is questionable whether it will be used to its optimal potential. If teachers are poorly trained in the effective integration of computer tutorials into the curriculum, there is a chance that the program will not be as beneficial as it could be. It is also a concern that teachers who have been in the field for a long time may not be as computer literate as teachers entering the profession.

In summary, multimedia has the capability of being an effective aid to teachers by giving students additional information to what was presented in class. By combining text, graphics, sound and video, presentations can be colorfully annotated and may help the student better associate facts and theories. Authoring systems such as ToolBook help simplify the design and implementation of such an application, although the integration of multimedia devices can still be tricky. It should be noted that it
was originally planned to include a video segment in the application, however the lack of time to discover the required software did not permit this to be accomplished. Hopefully the problem of effective and easy hardware integration will be overcome as technology advances.
Appendices
Appendix A: Sample Scripts

The following script is an example of code written in OpenScript and is used on page 14 of the Science Quest book. This is the only instance where draw direct was used for simplicity. The function of this code is to display the beam of colors after it goes through the first prism:

to handle buttonUp
    set sysFillColor to 300, 12.5625, 100
    draw irregularPolygon from 3660, 3045 \ to 5835, 2355 \ to 5760, 2475 \ to 3615, 3120 \ to 3660, 3045
    set name of selection to "BMagenta"
    set sysFillColor to 240, 12.5625, 100
    draw irregularPolygon from 3615, 3120 \ to 5760, 2460 \ to 5700, 2550 \ to 3570, 3210
    set name of selection to "BIndigo"
    set sysFillColor to 240, 50, 100
    draw irregularPolygon from 3570, 3210 \ to 3525, 3285 \ to 5670, 2640 \ to 5730, 2535 \ to 5730, 2550
    set name of selection to "BBlue"
    set sysFillColor to 120, 25.125, 100
    draw irregularPolygon from 3525, 3285 \ to 3480, 3360 \ to 5610, 2760 \ to 5670, 2640
    set name of selection to "BGreen"
    set sysFillColor to 60, 50, 100
    draw irregularPolygon from 3495, 3330 \ to 3450, 3420 \ to 3550, 2880 \ to 3595, 2775
    set name of selection to "BYellow"
    set sysFillColor to 30, 50, 100
    draw irregularPolygon from 3435, 3420 \ to 3375, 3510 \ to 5445, 3015 \ to 5535, 2880 \ to 5535, 2895
    set name of selection to "BOrange"
    set sysFillColor to 0, 50, 100
    draw irregularPolygon from 3375, 3510 \ to 3345, 3585 \ to 5385, 3135 \ to 5445, 3015 \
to 5475, 3015
set name of selection to "BRed"
pause 10 seconds
clear irregularPolygon "BMagenta"
clear irregularPolygon "BIndigo"
clear irregularPolygon "BBlue"
clear irregularPolygon "BGreen"
clear irregularPolygon "BYellow"
clear irregularPolygon "BOrange"
clear irregularPolygon "BRed"
go page "three"
end buttonUp

The following script is from page 15 and is the one actually used in the application. It shows the refraction through the second prism:

to handle buttonUp
    show irregularPolygon "B3Magenta"
    show irregularPolygon "B3Indigo"
    show irregularPolygon "B3Blue"
    show irregularPolygon "B3Green"
    show irregularPolygon "B3Yellow"
    show irregularPolygon "B3Orange"
    show irregularPolygon "B3Red"
    show irregularPolygon "B3White"
end buttonUp

The following script illustrates the original approach to animation through the use of Draw Direct. This was originally intended to do the same thing as the previous script, but gave error messages when objects were not present. The following script was therefore not actually used in the application, although it was initially intended for page 15 and is code to display refraction of light through the second prism:

to handle buttonUp
    set sysFillColor to 0, 50, 100
draw irregularPolygon from 5385, 3135 \ 
to 5445, 3015 \ 
to 7290, 3285 \ 
to 7305, 3330
set name of selection to "B3Magenta"
set sysFillColor to 30, 50, 100
draw irregularPolygon from 5535, 2895 \ 
to 5430, 3015 \ 
to 7275, 3270 \ 
to 7260, 3225
set name of selection to "B3Indigo"
set sysFillColor to 60, 50, 100
draw irregularPolygon from 5535, 2895 \ 
to 5610, 2775 \ 
to 7215, 3180 \ 
to 7245, 3225 \ 
to 7260, 3240
set name of selection to "B3Blue"
Appendix B: Diagram of Three Computer Assisted Learning Environments

The diagram on the following page was recreated from the diagram found on page 15 of Barker's book: Multimedia Computer Assisted Learning. It illustrates the different models that an educational multimedia package might be classified as.
Models of Computer Assisted Learning

Informatory CAL

Exploratory CAL

Instructional CAL
Appendix C: Science Quest Screens

The following pages show some of the screens from the Science Quest application. They were printed on a Hewlett Packard DeskJet 500, in draft mode. The printed pages are not exactly the same as the application's pages displayed on the screen. In several instances not all of the text displayed on the screen is printed on the page. It is also often the case, that pages containing highlighted text, show the highlight bar either above or to the right of the text, rather than directly over it.

Another discrepancy between the printed page and the online screen is the text displayed on the buttons. For example, all of the "exit" buttons on the screen show the entire word, however on the printed page, only "exi" is displayed on the button. Similar problems were found in printing pages with other buttons.

The following pages should give the reader a general idea of how the application was designed, however, in order to fully appreciate the colors, sound, and animation, (along with the proper display of text) the reader is encouraged to examine the actual ToolBook application. The ToolBook application can be found in the program group "Faith Ann and Rhonda's Thesis", under the icon "Science Quest". The source code is found in the directory "C:\REEFAN", in a program called "SCIENCE.TBK".
Thus, the combined action of these processes results in the blue light being scattered to form the sky. When light waves scatter all over the sky, the blue light is scattered more than other colors, making the sky appear blue.

Why is the Earth's sky bluer?
Click on a topic, or exit to return to the main menu.
Bibliography


